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About this guide
This chapter covers the following topics:
l What this guide covers (page 8)
l Conventions (page 8)
l About the documentation (page 9)
l Instrument technical support (page 10)



What this guide covers
This guide describes the procedures necessary to operate and maintain the BD FACSymphony™ A5 SE Special
Order Research Product (SORP) flow cytometer.

Because many cytometer functions are controlled by BD FACSDiva™ software, this guide also contains
information about software features required for basic cytometer setup and operation.

This guide assumes you have a working knowledge of basic Microsoft®Windows® operation. If you are not
familiar with the Windows operating system, see the documentation provided with your computer.

Conventions

Introduction

The following table lists the safety symbols used in this guide to alert you to potential hazards.

Safety symbols

Symbol Meaning

Caution alert

Identifies a hazard or unsafe practice that could result in data loss, material damage, minor injury, severe
injury, or death

Biological hazard

Electrical hazard

Laser hazard
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About the documentation

Introduction

This topic describes the documentation available with the BD FACSymphony™ A5 SE flow cytometer.

The following list includes the available documentation for the system.
l BD FACSDiva™ Software Reference Manual: Includes instructions or descriptions for installation and setup,

workspace components, acquisition controls, analysis tools, and data management. Access this manual from
the BD FACSDiva™ Software Help menu (Help > Documentation > Reference Manual), or by double-clicking
the shortcut on the desktop.

l BD® Cytometer Setup and Tracking Application Guide: Describes how to use the BD® Cytometer Setup and
Tracking (CS&T) features in BD FACSDiva™ software.

l BD FACSymphony™ A5 SE Flow Cytometer Site Preparation Guide contains specifications for:
o Cytometer weight and size
o Temperature and other environmental requirements
o Electrical requirements

l BD FACSymphony™ A5 SE Flow Cytometer Safety and Limitations: Provides descriptions of safety and
warning labels, general system hazards, specific risks, and laser, electrical, and biological hazards.

l BD® High Throughput Sampler User’s Guide: Describes how to set up and operate the BD® High Throughput
Sampler (HTS) option. It also contains a description of BD FACSDiva™ software features specific to the HTS.

l BD FACSFlow™ Supply System User’s Guide: Describes the optional automated sheath and waste fluid control
system.

Publication formats

This guide is provided in PDF format to provide an eco-friendly option.
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Instrument technical support

Introduction

This topic describes how to get technical assistance.

Contacting technical support

If technical assistance is required, contact your local BD Biosciences customer support representative or supplier.
Go to our website bdbiosciences.com for up-to-date contact information.

When contacting BD Biosciences, have the following information available:
l Product name, part number, and serial number
l Version of BD FACSDiva™ software you are using
l Any error messages
l Details of recent system performance

More information
l What this guide covers (page 8)
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Introduction
This chapter covers the following topics:
l System overview (page 12)
l Cytometer overview (page 12)
l Control panel (page 14)
l Fluidics system (page 15)
l Sheath and waste containers (page 19)
l Optics (page 20)
l Workstation (page 22)



System overview

About the system

The BD FACSymphony™ A5 SE system includes the flow cytometer, BD FACSDiva™ software v9.3 or later (for
Windows 10) running on the system workstation, the optional BD FACSFlow™ supply system (FFSS), and the
optional BD® High Throughput Sampler (HTS). Each component is described in detail in the following sections.

Number Components

1 Sheath and waste tanks

2 BD FACSymphony™ A5 SE flow cytometer

3 Computer workstation

Cytometer overview

Introduction

The BD FACSymphony™ A5 SE flow cytometer is an air-cooled multi-laser benchtop instrument with the ability
to acquire parameters for a large number of colors. It uses fixed-alignment lasers that transmit light through a
flow cell to cascadagon detector arrays. These detectors collect and translate the resulting fluorescence signals
into electronic signals. Cytometer electronics convert these signals into digital data.
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Components

The following figure shows the main components of the instrument. Each component is described in detail in the
following sections.

Number Component Number Component

1 Heat ventilation slots (top) 6 Sample injection port (SIP)

2 Control panel 7 Heat ventilation slots (side)

3 Power button 8 Air and fluidic ports

4 Electrical plug 9 Optics access doors (cacadagon detector arrays)

5 Fluidic sensors

Caution! Do not place any objects on top of the instrument. Blocking the ventilation may cause the instrument to
overheat.

Caution: Electrical Hazard! Do not place liquids on top of the instrument. Any spill of liquid into the ventilation
openings could cause electrical shock or damage to the instrument.
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Control panel

Overview

The following figure shows the components in the control panel, which are listed in the table.

Number Component

1 System indicators

2 Fluid control buttons

3 Sample flow rate buttons

4 Sample fine adjust buttons

5 Status screen

6 Mode button

More information
l Fluidics system (page 15)
l Optics (page 20)
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Fluidics system

Introduction

The fluidics system carries the sample out of the sample tube and into the sensing region of the flow cell. Cells
are carried in the sample core stream in single file and measured individually.

System indicators

There are two system indicators (System status and Activity) on the control panel.
l System status. Shows the status of the sheath and waste tank levels. The following table describes the LED

indicators, conditions that trigger them, and any action that must be taken.

LED color Status Action

Green Good None

Yellow
Caution! Sheath and waste tanks need attention.

Check tank levels

Red
Caution! Take immediate action.

l Empty waste tank

l Fill sheath tank

System status is also displayed on the Status screen. See Status screen (page 16) for a description of the
Status screen.

l Activity. Shows whether the cytometer power is on and the status of acquisition. The following table
describes the indicator LEDs, and the status that triggers them.

Indicator LED color Status

Steady pulse Blue Cytometer is powered on.

Fluctuates Blue Cells are passing through the flow cell.

Fluid control

The three fluid control buttons (Run, Standby, and Prime) set the cytometer operation.
l Run Pressurizes the sample tube to transport the sample through the sample injection tube and into the flow

cell.
The Run button is green when the sample tube is on and the support arm is centered. When the tube support
arm is moved left or right to remove a sample tube, the cytometer switches to an automatic standby status
to conserve sheath fluid, and the Run button changes to orange.

l Standby Stops fluid flow to conserve sheath fluid.
When you leave the cytometer for more than a fewminutes, place a tube containing 1 mL of deionized (DI)
water on the sample injection port (SIP) and press Standby.

l Prime Prepares the fluidics system by draining and filling the flow cell with sheath fluid.
The fluid flow initially stops, and pressure is reversed to force fluid out of the flow cell and into the waste
container. After a preset time, the flow cell fills with sheath fluid at a controlled rate to prevent bubble
formation or entrapment. At completion, the cytometer switches to standbymode.
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Sample flow rate control

The three flow rate control buttons (LOW, MED, HIGH) set the sample flow rate through the flow cell. The
SAMPLE ADJ buttons allow you to adjust the rate to intermediate levels.

Number Component

1 Status screen

2 Sample flow rate buttons

3 Sample fine adjust buttons

When sample adj is set at the midpoint of 250 (as shown on the status screen on the control panel) the sample
flow rates at the low, med, and high settings are approximately 12, 35, and 60 µL/min of sample, respectively.
Each time you press one of the SAMPLE ADJ buttons, the fine adjust of the indicated sample increases or
decreases by 10. The following table shows the approximate sample flow rate range for low, medium, and high.

Settings Sample flow rate (µL/min)

Low 6–24

Med 17.5–70

High 30–120

Status screen

When not in FFSS mode, the first two lines of the status screen show the level of the waste and sheath tanks.
The third line toggles between Fine Adj. and Air Pressure. Status is described in detail in the following table.
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Item Definition

1 Waste level. Shows range (1) from E (empty) to F (full). The display line increases from left to right in sequences of
20%. System status turns yellow at 80%, and red at 100% full.

2 Sheath level. Shows range from E to F. The display line decreases from right to left in sequences of 20% from full
level. System status turns yellow at 20%, and red at 0%.

3 Fine Adj. Shows the current setting of fine adjust. Fine adjust can be set in increments of 10 from 0 to 500. The
last value persists, even after cytometer shutdown.

Air pressure. Shows the air pressure as either greater than (>) 5.4 psi, or less than (<) 5 psi. To display psi, press
the Mode button, followed by the Up button.

4 FFSSMode. Shows that the cytometer is in FFSS mode. To enter this mode, press the MODE button 4 times. After
you reach FFSS OFF, push the SAMPLE ADJ button once. You should now see the panel display FFSS ON. To exit,
press the MODE button 4 times, then SAMPLE ADJ button once. Repeat the process to turn FFSS mode off.

Fluidic alarms and the Mode button

The fluidic alarms are triggered by the waste and sheath fluid levels in the tanks. The alarms sound when the
waste tank is nearly 100% full and the sheath tank is empty.

To silence the alarm, press the Mode button, then press the Down button. The Mode button flashes to indicate
the cytometer is in silent mode. Repeat this sequence to turn off silent mode.

Note:When the cytometer is in FFSS mode, the alarms are deactivated.

Sample injection port

The SIP is where the sample tube is installed. The SIP includes the sample injection tube and the tube support
arm. Samples are introduced through a stainless steel injection tube equipped with an outer droplet
containment sleeve. The sleeve works in conjunction with a vacuum pump to eliminate droplet formation of
sheath fluid as it backflushes from the sample injection tube.
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Key Description

1 Tube support arm

2 Outer sleeve

3 Sample injection tube

Sample injection tube

Stainless steel tube that carries sample from the sample tube to the flow cell. This tube is covered with an outer
sleeve that serves as part of the droplet containment system.

Tube support arm

Arm that supports the sample tube and activates the droplet containment system vacuum. The vacuum is on
when the arm is positioned to the side and off when the arm is centered.

Note: If a sample tube is left on the SIP with the tube support arm to the side (vacuum on), the sample will be
aspirated into the waste container.

Cautions when using the HTS option
Caution: Biohazard!When using the flow cytometers with the HTS, ensure that the HTS is completely pushed
into the operating position before removing the droplet containment module (DCM) sleeve or disconnecting the
sample coupler from the SIP. This is to avoid accidental leakage of potentially biohazardous liquids directly onto
the instrument. With the HTS in the proper location, the containment dish with padding is directly below the SIP.

Caution! If you are using the HTS option, always slide the HTS mount slowly to prevent sample cross-
contamination when the wells are full. Never move the HTS when it is in operation.

Caution! Do not lean on or put any weight on the HTS as it could damage the instrument.
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Droplet containment module

The droplet containment module (DCM) prevents sheath fluid from dripping from the SIP and provides
biohazard protection.

Note: The DCM will not run when the HTS selector switch is in Plate Mode.

When no sample tube is installed on the SIP, sheath fluid backflushes through the sample injection tube. This
backflush helps prevent carryover of cells between samples. The DCM vacuum is activated when the sample
tube is removed and the tube support arm is moved to the side. Sheath fluid is aspirated as it backflushes the
sample injection tube.

Sheath and waste containers

Introduction

This topic describes the sheath and waste containers. The sheath and waste containers are outside the
cytometer and are positioned on the floor. The sheath and waste containers should remain in the installed
position. Moving them to a different height (for example, from the floor to a bench) changes the flow rate.

Note: If you are using the FFSS, see the BD FACSFlow™ Supply System User’s Guide.

Sheath container

The sheath container has a capacity of 10 L. Sheath fluid is filtered through an in-line, interchangeable filter
that prevents small particles from entering the sheath fluid lines. An alarm sounds when the container is empty.

Caution! Do not fill the sheath tank to its maximum capacity. When an overfull tank is pressurized, erratic
cytometer performance can result.

Waste container

The waste container has a capacity of 10 L. An alarm sounds when the container is full. If the waste container
overfills, install a replacement waste tank cap and baffle.

More information
l Preparing the sheath container (page 25)
l Preparing the waste container (page 29)
l Status screen (page 16)
l Fluidic alarms and the Mode button (page 17)
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Optics

Introduction

This topic describes the optical components for the BD FACSymphony™ A5 SE flow cytometer including:
l Detector arrays
l Laser options
l Optical filters
l Signal detectors

Detector arrays

The detector arrays consist of cascadagon arrays. Each cascadagon is outfitted with 2 to 20 PMTs and can
detect the corresponding number of signals.

Laser options

The flow cytometers can be configured with up to 10 lasers. The following table lists the lasers:

Laser Wavelength (nm) Power (mW)

Violet 405 200

Blue 488 150

UV 355 60

Yellow Green 561 150

Red 637 140

Optical filters

Optical filters attenuate light or help direct it to the appropriate detectors. The name and spectral
characteristics of each filter appear on its holder.

There are two types of optical filters in the BD FACSymphony™ A5 SE flow cytometer:
l Longpass dichroic mirrors (LPs) Transmit wavelengths that are longer than the specified value and reflect all

light below the specified wavelength.
l Bandpass filters (BPs) Pass a narrow spectral band of light.

When dichroic filters are used as steering optics to direct different color light signals to different detectors, they
are called dichroic mirrors. LP dichroic mirrors transmit longer wavelengths to one detector while reflecting
shorter wavelengths to a different detector.
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Signal detectors

Particles in the fluid stream passing through the laser beam absorb energy are excited to emit photons at
discrete lower frequencies. When these photons reach a detector, electrical pulses are created that are then
processed by the electronics system.

There are two types of signal detectors in the BD FACSymphony™ A5 SE flow cytometer:
l PMTsUsed to detect the weaker signals generated by side scatter (SSC) and all fluorescence channels. These

signals are amplified by applying a voltage to the PMTs.
l Photodiodes. Less sensitive to light signals than the PMTs. A photodiode is used to detect the stronger

forward scatter (FSC) signal.

Laser/Detector/Mirror/Filter Combinations

Each PMT has an optic holder in front of it. The optic holders are labeled with numbers indicating the
wavelengths of the bandpass filter and longpass dichroic mirror they contain (for example, 780/60 and 750 LP,
respectively). The optic holder in front of the last PMT in the detector array contains only a bandpass filter and is
marked accordingly.

Base configurations

Each flow cytometer has a base cytometer configuration that corresponds to the layout of the installed lasers
and optics in your cytometer. This base configuration is factory set.

Cytometer configuration in BD FACSDiva™

BD FACSDiva™ software provides a base configuration for your flow cytometer. In the case of the
BD FACSymphony™ A5 SE flow cytometer, the base configuration corresponds to the fixed configuration for the
spectral function. For details, see Spectral Functions (page 47). Select Cytometer > View Configuration to
create, modify or delete custom configurations for compensation cytometry. (See the Cytometer and
Acquisition Controls chapter of the BD FACSDiva™ Software Reference Manual.)
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Workstation

Introduction

This topic describes the components of the workstations.

Workstation components

Acquisition, analysis, and most instrument functions are controlled by the workstations. They include a PC and
one or two monitors. Your workstation is equipped with the following:
l Microsoft Windows operating system
l BD FACSDiva™ software version 9.3 or later for Windows 10 for data acquisition and analysis
l Software documentation including the help system accessible from amenu in the BD FACSDiva™ software.
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Cytometer setup
This chapter covers the following topics:
l Starting the cytometer and computer (page 24)
l Preparing the sheath container (page 25)
l Removing air bubbles (page 27)
l Preparing the waste container (page 29)
l Preparing the fluidics (page 31)
l Adding a bead lot number (page 32)
l Custom configurations and baselines (page 34)



Starting the cytometer and computer

Introduction

This topic describes how to start the cytometer and turn on the computer.

Note: If your system is using the FFSS, make sure that the FFSS is powered on before the cytometer.

Procedure

To start the cytometer:
1. Turn on the power to the flow cytometer.
2. Turn on the computer and log in to Windows.

Note: You can turn on the power to the flow cytometer and the workstation in any order.
3. Turn on the lasers.
4. Allow 30minutes for the optical system temperature to stabilize.

Caution! Failure to warm up and stabilize the instrument could affect sample data.

5. Start BD FACSDiva™ software by double-clicking the shortcut on the desktop, and log in to the software.
6. Check the Cytometer window in BD FACSDiva™ software to ensure that the cytometer is connected to the

workstation.
The cytometer connects automatically. While connecting, the message “Cytometer Connecting” is displayed
in the status area of the Cytometer window. When connection completes, the message changes to
“Cytometer Connected.”

If the message does not change from “Cytometer Connecting”, see Electronics troubleshooting (page 101).

24 BD FACSymphony™ A5 SE User's Guide



Preparing the sheath container

Introduction

This topic describes how to prepare the sheath container.

Note: If your system is using the FFSS, see the BD FACSFlow™ Supply System User’s Guide.

When to check the sheath and waste containers

Check the fluid levels in the sheath container and waste container every time you use the cytometer. This
ensures that you do not run out of sheath fluid during an experiment and that the waste container does not
overflow.
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Sheath container components

The sheath container components are shown in the following image:

Item Number Component

1 Cap handle

2 Filter assembly

3 Sheath fluid line (blue) to flow cytometer

4 Air line (green)

5 Alarm sensor

6 Clamp knob

7 Vent valve

Procedure

To prepare the sheath container:
1. Verify that the flow cytometer is in standbymode.

Press the STANDBY button on the control panel if necessary.
2. Disconnect the green air line, sheath fluid line, and alarm sensor from the sheath container.
3. Depressurize the sheath container by pulling up on the vent valve.
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4. Remove the sheath container lid.
Unscrew the clamp knob and push down to loosen, if necessary. Tilt the cap to the side to remove it from the
tank.

5. Add 10 L of sheath fluid, such as BD FACSFlow™ solution, to the sheath container.

Note: The 10 L will reach the interior line on the sheath tank. Do not fill the sheath tank further.
6. Replace the sheath container lid.
7. Reconnect the green air line and the alarm line.
8. Make sure the gasket on the inside lip of the sheath lid is seated correctly and has not slipped out of position.

If the gasket is not seated correctly, the tank will not pressurize properly.
9. Close the sheath lid and tighten the clamp knob to finger-tight. Ensure that the blue sheath fluid line is not

kinked.

More information
l Removing air bubbles (page 27)
l Changing the sheath filter (page 41)
l Cleaning or replacing the sheath gasket (page 45)

Removing air bubbles

Introduction

This topic describes how to remove trapped air bubbles in the sheath filter and the sheath line. Air bubbles can
occasionally dislodge and pass through the flow cell, resulting in inaccurate data.

Note: Perform this activity every time the sheath tank is refilled.
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Procedure

To remove air bubbles:
1. Check the sheath filter for trapped air bubbles.

Item Number Component

1 Flow cytometer fluid line (roller clamp not visible)

2 Vent fitting

3 Vent line

2. If bubbles are visible, gently tap the filter body with your fingers to dislodge the bubbles and force them to
the top.

Caution!When removing air bubbles, do not vigorously shake, bend, or rattle the sheath filter or you might
damage it.
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3. Direct the vent line into a beaker and press the small button at the end of the vent fitting against the side of
the beaker until a steady stream of fluid empties from the filter.

Item Number Component

1 Button

2 Vent fitting

4. Tilt the filter and verify that no trapped air remains in the filter.
5. Repeat steps 3 and 4 until no air is observed in the filter.
6. Check the sheath line for air bubbles.
7. Open the roller clamp at the fluidics interconnect (if necessary) to bleed off any air in the line. Collect any

excess fluid in a waste container.
8. Close the roller clamp.

Preparing the waste container

Introduction

This topic describes how to prepare the waste container. Prevent waste overflow by emptying the waste
container daily or whenever the system status indicator turns yellow.

Note: If your system is connected to the FFSS, see the documentation provided with your FFSS.

Caution: Biohazard! All biological specimens and materials coming into contact with them are considered
biohazardous. Handle as if capable of transmitting disease. Dispose of waste using proper precautions and in
accordance with local regulations. Never pipette by mouth. Wear suitable protective clothing, eyewear, and gloves.

Chapter 3  Cytometer setup 29



Waste container components

The following figure shows the main components of the waste container.

5

4

3

21

Item Number Component

1 Baffle

2 User-replacable cap

3 Air line

4 Alarm sensor

5 Waste fluid line with clip

Biological precautions
Caution: Biohazard! Contact with biological specimens and materials can transmit potentially fatal disease.

To prevent exposure to biohazardous agents:

l Put the flow cytometer in standbymode before disconnecting the waste tank, to avoid leakage of
biohazardous waste.

l Always disconnect the waste tank from the flow cytometer before you empty it. Wait at least 30 seconds for
pressure to dissipate before you remove the waste cap or sensor.

l Expose waste tank contents to bleach (10% of total volume) for 30 minutes before disposal.

l Do not wet the waste tank cap. If wet, the filter in the cap will cause the tank to malfunction. To keep the
cap dry, place it on the bench label-side up when it is not on the tank.

l If the waste tank overflows always install a replacement waste tank cap and baffle.
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Procedure

To prepare the waste container:
1. Verify that the flow cytometer is in standbymode.

Press the STANDBY button on the control panel if necessary.
2. Disconnect the orange waste tubing and the black alarm sensor line from the waste container.

Keep the lid on the waste container until you are ready to empty it.
3. Empty the waste container.

Caution! The waste container is heavy when full. When emptying it, use good body mechanics to prevent
injury.

4. Add approximately 1 L of bleach to the waste container and close it.
5. Reconnect the orange waste tubing and make sure it is not kinked.
6. Reconnect the black alarm sensor line.

Preparing the fluidics

Introduction

This topic describes how to prepare the fluidics system.

When to prime the fluidics

Sometimes, air bubbles and debris may become lodged in the flow cell. This is indicated by excessive noise in the
forward and side scatter parameters (FSC and SSC, respectively). In these cases, it is necessary to prime the
fluidics system. Priming introduces air to the flow cell. Following the procedures below minimize the need for
priming and make priming more effective when needed.

Procedure

Start up the fluidics:
1. Turn on the computer and instrument as described in Starting the cytometer and computer (page 24).

2. Install a tube with 3 mL of 1.5% dilution of BD® Detergent Solution Concentrate on the SIP and put the
tube support arm underneath the tube.

Note: The BD® Detergent Solution Concentrate must be diluted before use. Mix one full 15 mL bottle of
BD® Detergent Solution Concentrate into 985 mL of DI water to make 1 L total.

3. Press RUN and HIGH on the cytometer fluid control panel. Run for 10minutes.
4. Remove the tube of detergent from the SIP and replace with a tube containing 3 mL of DI water.
5. Again, press RUN and HIGH on the cytometer fluid control panel. Run for 10minutes.

Determine whether or not the fluidics need to be debubbled by priming:

1. Open or create an experiment to view BD® CS&T Beads. For details, see Running a performance check (page
67) and Setting up a compensation experiment (page 69).

2. Press RUN and LOW on the cytometer fluid control panel.
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3. Observe the plots for the scatter channel and fluorescent channels. There should be two distinct peaks for
each scatter channel and three distinct peaks for each fluorescent channel. The coefficient of variation (CV)
for bright peaks should be narrow. If either the CVs are very wide on a detector or no signal is observed, the
fluidics need to be primed as described in the following procedure.

To prime the fluidics:
1. Move the tube support arm to the side.
2. Remove the tube from the SIP or leave the HTS connected to the SIT.
3. Press the PRIME fluid control button to force the fluid out of the flow cell and into the waste container.

Once drained, the flow cell automatically fills with sheath fluid at a controlled rate to prevent bubble
formation or entrapment. The STANDBY button turns amber after completion.

4. When the STANDBY light is on, install a test tube of DI water or leave the HTS connected to the SIT.

5. Press the RUN fluid control button and run for 10 seconds.

6. Press the PRIME button immediately followed by the RUN button.

7. Repeat step 6 ten times.

If more than 2 seconds pass between PRIME and RUN in step 6, restart the procedure.

8. Install a 12 × 75mm tube with 1 mL of DI water on the SIP and place the support arm under the tube. Leave
the cytometer in standbymode.

More information
l Cytometer troubleshooting (page 96)

Adding a bead lot number
You need to be an administrator to perform this procedure.

Do not import a bead lot file as described in the BD® Cytometer Setup and Tracking Application Guide as the
standard bead lot files are not applicable to the BD FACSymphony™ A5 SE flow cytometer. Use the following
procedure to add a bead lot number instead.

Procedure

To add a bead lot number:
1. Select Cytometer > CST.
2. In the CS&T workspace, select Tools > Bead Lots.

The Bead Lots dialog opens.
3. Click New.
4. Enter the 6-digit part number for the BD® Cytometer Setup and Tracking Beads.

5. Enter the bead lot number.
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6. Enter the expiration date.

7. Click OK.
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Custom configurations and baselines

Introduction

This topic describes where to find information on how to create a custom configuration and define a baseline for
a performance check.

Overview

BD® Cytometer Setup Software (CS&T) software is used to define the baseline performance of your cytometer.
A baseline provides a starting point for the tracking of cytometer performance. When running a performance
check, you compare the results to the baseline.

See Optimizing cytometer settings (page 63). See the latest published filter guides available on our website
(bdbiosciences.com) for more information.

See the BD Cytometer Setup and Tracking Application Guide for information about creating custom
configurations and defining a baseline.

More information
l Running a performance check (page 67)
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Maintenance
This chapter covers the following topics:
l Maintenance overview (page 36)
l Cleaning the fluidics (page 37)
l Shutting down the cytometer (page 38)
l Flushing the system (page 38)
l Replacing the waste container cap (page 40)
l Changing the sheath filter (page 41)
l Changing the Bal seal (page 42)
l Changing the sample tube O-ring (page 44)
l Cleaning or replacing the sheath gasket (page 45)



Maintenance overview

Introduction

This topic provides an overview of the flow cytometer routine maintenance and cleaning procedures.

General use guidelines
Caution: Biohazard! Contact with biological specimens and materials can transmit potentially fatal disease.

Follow these guidelines whenever operating or maintaining the cytometer:
l Wear suitable protective clothing, eyewear, and gloves.
l Handle all biological specimens and materials in accordance with applicable regulations and manufacturer

specifications.
l Dispose of waste using proper precautions and in accordance with local regulations.
l Never pipette by mouth.

For fluidics maintenance, we recommend the following cleaning solutions:
l BD FACSClean™

l BD® Detergent Solution Concentrate

l 10% bleach solution

Use DI water to dilute bleach to appropriate concentrations.

Caution! Higher concentrations of sodium hypochlorite and use of other cleaning solutions might damage the
cytometer.

When to perform maintenance procedures

Perform maintenance procedures in the following frequencies.

Frequency Maintenance procedure

Daily l Cleaning the fluidics (page 37)

l Shutting down the cytometer (page 38)

Scheduled (every two weeks) l Flushing the system (page 38)

Periodic (frequency depends on how often you run the cytometer) l Changing the sheath filter (page 41)

l Changing the Bal seal (page 42)

l Changing the sample tube O-ring (page 44)

l Cleaning or replacing the sheath gasket (page
45)
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Cleaning the fluidics

Introduction

This topic describes how to perform the daily fluidics cleaning.

Overview

Cleaning the fluidics daily prevents the sample injection tube from becoming clogged and removes dyes that
can remain in the tubing.

In addition to daily cleaning, follow this procedure immediately after running viscous samples or nucleic acid
dyes such as Hoechst, DAPI, propidium iodide (PI), acridine orange (AO), or thiazole orange (TO).

Procedure

To clean the fluidics:
1. Press RUN and HIGH on the cytometer fluid control panel.
2. Install a tube containing 3 mL of a cleaning solution on the SIP with the support arm to the side (vacuum on)

and let it run for 1 minute.
For the cleaning solution, use BD FACSClean™ solution. See Maintenance overview (page 36) for other
recommended cleaning solutions.

3. Move the tube support arm under the tube (vacuum off) and allow the cleaning solution to run for 5 minutes
with the sample flow rate set to HIGH.

4. Repeat steps 2 and 3 with DI water.

5. Repeat steps 2 and 3 with 1.5% dilution of BD® Detergent Solution Concentrate.

Note: The BD® Detergent Solution Concentrate must be diluted before use. Mix one full 15 mL bottle of
BD® Detergent Solution Concentrate into 985 mL of DI water to make 1 L total.

Caution! Do not mix BD® Detergent Solution Concentrate and bleach because they produce chlorine gas.

6. Repeat steps 2 and 3 with DI water.
7. Press the STANDBY button on the fluidics control panel.
8. Place a tube containing no more than 1 mL of DI water on the SIP.

A tube with 1 mL of DI water should remain on the SIP to prevent salt deposits from forming in the injection
tube. This tube also catches back drips from the flow cell.

Caution! Do not leave more than 1 mL of water on the SIP. When the instrument is turned off or left in
standby mode, a small amount of fluid will drip back into the sample tube. If there is too much fluid in the
tube, it could overflow and affect the cytometer performance.
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Shutting down the cytometer

Introduction

This topic describes how to shut down the cytometer.

Before you begin

Each time you shut down the cytometer, perform the daily cleaning as described in Cleaning the fluidics (page
37).

Procedure

To shut down the cytometer:
1. Place a tube of DI water on the SIP.
2. Turn off the flow cytometer.
3. Select Start > Shutdown to turn off the computer (if needed).
4. If your system is connected to the FFSS, shut off the FFSS.

If the cytometer will not be used for a week or longer, perform a system flush and leave the fluidics system filled
with DI water to prevent saline crystals from clogging the fluidics.

More information
l Cleaning the fluidics (page 37)
l Flushing the system (page 38)

Flushing the system

Introduction

This topic describes how to perform an overall fluidics cleaning to remove debris and contaminants from the
sheath tubing, waste tubing, and flow cell. Perform the system flush at least every 2 weeks.

Note: After installation of a new system or major repair of the fluidics system, perform a system flush with
overnight soak twice a week for one month.

Note: If you are using the FFSS, see the BD FACSFlow™ Supply System User’s Guide for instructions on flushing
the system.

Cautions
Caution: Biohazard! The cytometer hardware might be contaminated with biohazardous material. Use 10%
bleach to decontaminate the instrument.
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Procedure

To perform a system flush:
1. Remove the sheath filter.

a. Press the quick-disconnects on both sides of the filter assembly.
b. Remove the filter assembly.
c. Connect the two fluid lines.

Caution! Do not run detergent, bleach, or ethanol through the sheath filter. They can break down the filter
paper within the filter body, causing particles to escape into the sheath fluid, possibly clogging the flow
cell.

2. Empty the sheath container and rinse it with DI water.
3. Fill the sheath container with at least 1 L of undiluted BD FACSClean™ solution.
4. Empty the waste container, if needed.
5. Open the roller clamp by the fluidics interconnect, and drain the fluid into a beaker for 5 seconds.
6. Remove the DI water tube from the SIP.
7. Prime the instrument twice:

a. Press the PRIME button on the fluidics control panel.
b. When the STANDBY button lights (amber), press the PRIME button again.

8. Install a tube with 3 mL of undiluted BD FACSClean™ solution on the SIP and put the tube support arm
underneath the tube.
See Maintenance overview (page 36) for other recommended cleaning solutions.

9. Press RUN and HIGH on the cytometer fluid control panel. Run for 30minutes.
10. Press the STANDBY fluid control button and depressurize the sheath container by lifting the vent valve.

11. Empty the waste container to avoid the mixing of bleach and BD® Detergent Solution Concentrate.

Caution! Do not mix BD® Detergent Solution Concentrate and bleach because they produce chlorine gas.

12. Repeat steps 2 through 10 with 1.5% dilution of BD® Detergent Solution Concentrate.

Note: The BD® Detergent Solution Concentrate must be diluted before use. Mix one full 15 mL bottle of
BD® Detergent Solution Concentrate into 985 mL of DI water to make 1 L total.

13. Leave the system filled with 1.5% dilution of BD® Detergent Solution Concentrate overnight to soak (if
possible, up to 18 hours) to reduce air adhesion throughout the system. When soaking, the system power
should be disconnected and secured. Upon completion of the soak period, restore power and continue to the
next step in this procedure .

14. Repeat steps 2 through 10 with DI water.
15. Replace the sheath filter and refill the sheath container with sheath fluid.
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Replacing the waste container cap

Introduction

This topic describes how to replace the waste container cap. Replace the cap once a month.

Biological precautions
Caution: Biohazard! Contact with biological specimens and materials can transmit potentially fatal disease.

To prevent exposure to biohazardous agents:
l Put the cytometer in standbymode before disconnecting the waste tank to avoid leakage of biohazardous

waste.
l The waste container can become pressurized when the cytometer is running. Always disconnect the waste

container from the cytometer before you empty it. Wait at least 30 seconds for pressure to dissipate before
you remove the waste cap or sensor.

l Expose waste container contents to bleach (10% of total volume) for 30 minutes before disposal.

Procedure

To replace the cap:
1. Put the cytometer in standbymode.
2. Disconnect the waste container’s sensor line and orange waste line from the waste container tank, and wait

at least 30 seconds for pressure to dissipate.
3. Remove the waste cap and attached baffle from the container and place on the bench label-side up.
4. Detach the cap from the baffle. If there is fluid in the baffle, replace it with a new one.
5. Place a new cap on the baffle.
6. Write the date on the cap label.

338677 Rev A

Waste (A)

Space for date

7. Screw the cap assembly onto the waste container and hand-tighten until it is fully closed.

Caution: Biohazard! To prevent waste container overpressurization, do not overtighten the trap or attached
filter cap. Tighten each component only until it is hand-tight. Do not use sealants such as Teflon® tape or
other adhesives.

Re-attach the alarm sensor line and waste line to the waste container tank.
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Changing the sheath filter

Introduction

This topic describes how to change the sheath filter. The sheath filter is connected in-line with the sheath line. It
filters the sheath fluid as it comes from the sheath container.

When to change the sheath filter

We recommend changing the sheath filter assembly every six months. Increased debris appearing in an FSC vs
SSC plot can indicate that the sheath filter needs to be replaced. See Supplies and consumables (page 103) for
ordering information.

Sheath filter components

The following illustration shows the sheath filter components.

Item Number Component

1 Sheath line

2 Quick disconnect

3 Vent fitting

4 Filter base
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Removing the old filter

To remove the old filter:
1. Place the cytometer in standbymode.
2. Remove the sheath filter assembly by pressing the quick-disconnect on both sides of the filter assembly.
3. Over a sink or beaker:

l Remove the vent line from the filter and set it aside.
l Remove the filter base and set it aside.

4. Discard the used filter assembly in an appropriate receptacle.

Attaching the new filter

To attach the new filter:
1. Connect the vent line to the new filter assembly.

Twist to attach.
2. Wrap Teflon tape around the filter threads, then connect the filter to the filter base.
3. Connect the sheath line to the filter assembly by squeezing the quick-disconnect.
4. Attach the cytometer fluid line to the filter assembly via the quick-disconnect.
5. Direct the vent line into a beaker and press the small button at the end of the vent fitting against the side of

the beaker until a steady stream of fluid empties from the filter.
6. Tilt the filter and verify that no trapped air remains in the filter.
7. Repeat steps 5 and 6 as necessary to remove all trapped air.

Changing the Bal seal

Introduction

This topic describes how to replace the Bal seal.

The sample injection tube Bal seal is a ring that forms a seal with the sample tube and ensures proper tube
pressurization.

When to change the Bal seal

Over time, the Bal seal becomes worn or cracked and requires replacement. Replacement is necessary if a proper
seal is not formed when a sample tube is installed on the SIP. Indications that a proper seal has not formed
include:
l The tube will not stay on the SIP without the tube support arm.
l When the tube is installed and RUN is pressed on the cytometer, the RUN button is orange (not green).
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Procedure

To replace the Bal seal:
1. Remove the outer sleeve from the sample injection tube by turning the retainer counterclockwise. Slide the

outer sleeve down and off of the sample injection tube.

Item Number Component

1 Bal seal

2 Retainer

3 Outer sleeve

4 Sample injection tube

Work carefully. The outer sleeve can fall off as you loosen the retainer.
2. Remove the Bal seal by gripping it between your thumb and index finger and pulling down.

3. Install the new Bal seal spring-side up.
Ensure that the sample tube O-ring is still in place inside the retainer.

4. Re-install the retainer and outer sleeve over the sample injection tube. Push the outer sleeve all the way up
into the sample injection port and then screw the retainer into place and tighten to finger tight. This will seat
the Bal seal.

5. Install a sample tube on the SIP to ensure that the outer sleeve has been properly installed.
If the sleeve hits the bottom of the tube, loosen the retainer slightly and push the sleeve up as far as it will
go. Tighten the retainer.
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Changing the sample tube O-ring

Introduction

This topic describes how to replace the sample tube O-ring.

The sample tube O-ring, located within the retainer, forms a seal that allows the droplet containment vacuum to
function properly.

When to replace the O-ring

Replace the O-ring when droplets form at the end of the sample injection tube while the vacuum is operating.

Caution
Caution: Biohazard! Cytometer hardware might be contaminated with biohazardous material. Wear suitable
protective clothing, eyewear, and gloves whenever cleaning the cytometer or replacing parts.

Procedure

To change the O-ring:
1. Remove the outer sleeve from the sample injection tube by turning the retainer counterclockwise.
2. Slide the outer sleeve from the retainer.

Item Number Component

1 O-ring

2 Retainer

3. Invert the outer droplet sleeve and allow the O-ring to fall onto the benchtop.
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If the O-ring does not fall out initially, hold the O-ring with your free hand and slide the outer sleeve to
remove the O-ring.

4. Place the new O-ring into the retainer. Make sure the O-ring is seated properly in the bottom of the retainer.
5. Replace the outer sleeve in the retainer.
6. Re-install the retainer and the outer sleeve.
7. Install a sample tube on the SIP to ensure that the outer sleeve has been properly installed.

If the sleeve hits the bottom of the tube, loosen the retainer slightly and push the sleeve up as far as it will
go. Tighten the retainer.

Cleaning or replacing the sheath gasket

Introduction

This topic describes how to clean or replace the gasket of the sheath tank lid.

When to change the sheath filter

We recommend cleaning the sheath gasket when needed.

Procedure

To clean or replace the gasket:
1. Put the cytometer in standbymode.
2. Depressurize the sheath container by pulling up on the vent valve.
3. Remove the lid from the sheath tank.
4. Remove the black gasket from the lid.
5. Rinse it with water to clean the gasket.
6. Place the clean gasket or the new gasket on the lid and make sure the gasket is seated properly on the lid.
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Spectral Functions
This chapter covers the following topics:
• Spectral function overview (page 48)
• Autofluorescence (page 52)
• Spectral unmixing software considerations (page 53)
• Setting up a new spectral experiment (page 53)
• Setting up the Spectral Unmixing algorithm (page 56)
• Recording and analyzing spectral data (page 59)
• Repeating a spectral experiment (page 61)



Spectral function overview
Spectral flow cytometry represents an alternative measurement strategy to compensation flow cytometry. In
both cases, surface markers or intracellular analytes on single cells are quantified bymeasuring antigen-specific
fluorescent labels with varying spectral properties.

Compensation flow cytometry follows a paradigm of one detector per label in which the intensity of light
emitted from the different labels is measured using label-specific photodetectors. The resulting data is
subsequently transformed through a process called “compensation” to correct for the effects of spectral overlap
between different fluorophores. Mirrors and filters that are broad enough to identify the target fluorescent label
but also narrow enough to limit fluorescent spillover direct discrete portions of emitted light from each
fluorescent label to the corresponding detector. This can lead to the omission of portions of spectral information
that, when measured and transformed appropriately, could have aided in discriminating one fluorescent label
from another.

In contrast, spectral cytometry uses a set of photodetectors spanning the visible spectrum—similar to a
traditional spectrometer—to sample the full emission spectrum of all fluorescent labels present on the cell, and
then uses a deconvolution process called spectral unmixing to determine the underlying label abundances. In
spectral cytometry, sampling the full spectrum allows the cytometer to collect all light emitted from fluorescent
labels and distinguish them from others in a multicolor experiment. This can provide advantages in flexibility of
fluorescent label inputs without having to change filters, as well as the ability to multiplex more fluorescent
labels in one multicolor sample.

In both cases, spillover spreading remains the primary limiting factor for panel performance and both spectral
and compensation sampling methods entail many of the same requirements for experimental design and
customer workflow. It is critical in both cases for single-stained reference controls to match the final sample as
closely as possible. However, spectral cytometry can be more sensitive to discrepancies between the
fluorochrome spectra in single-stained controls and the fully stained sample of interest.

The BD FACSymphony™ A5 SE is an RUO solution for a high-parameter spectral analyzer. Its spectral capabilities
are enabled by the combination of optimized fixed configurations of lasers, standard filter set, and detectors.
The software for the instrument, BD FACSDiva™ v9.3 or later, supports customer workflows that can be either
spectral or traditional compensation experiments. This section describes the spectral functionality and
workflows.

The BD FACSymphony™ A5 SE is a 5-laser, 48-fluorescent-channel instrument where each channel is assigned to
a specific laser. The number of channels assigned to each laser is as follows:
l UV laser: 10 fluorochrome channels
l Violet laser: 14 fluorochrome channels
l Blue laser: 9 flurochrome channels + side-scatter channel (SSC)
l Yellow-green laser: 9 fluorochrome channels
l Red laser: 6 fluorochrome channels

For each laser, each of its channels is routed to a different detector. As can be seen from the following figure,
the only significant gaps in spectral response are near the laser emission wavelengths.
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The BD FACSymphony™ A5 SE achieves the illustrated spectral responses using the following laser
/detector/filter combinations:
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Laser Detector Channel Mirror Filter Parameter

Blue (488 nm) A 10 770 LP 810/79 BP B810

B 9 724 LP 750/60 BP B750

C 8 685 LP 710/50 BP B710

D 7 665 LP 675/20 BP B675

E 6 645 LP 660/30 BP B660

F 5 585 LP 602/40 BP B602

G 4 570 LP 576/20 BP B576

H 3 520 LP 537/32 BP B537

I 2 500 LP 510/20 BP B510

J 1 – 488/10 BP SSC

Red (637 nm) A 16 750 LP 780/60 BP R780

B 15 720 LP 730/50 BP R730

C 14 699 LP 710/25 BP R710

D 13 680 LP 680/30 BP R680

E 12 665 LP 675/20 BP R675

F 11 645 LP 660/30 BP R660

Violet (405 nm) A 28 810 LP 845/70 BP V845

B 27 765 LP 785/50 BP V785

C 26 730 LP 750/40 BP V750

D 25 690 LP 710/40 BP V710

E 24 665 LP 680/30 BP V680

F 23 645 LP 660/30 BP V660

G 22 605 LP 615/25 BP V615

H 21 585 LP 595/30 BP V595

I 20 570 LP 576/20 BP V576

J 19 530 LP 540/20 BP V540

K 18 495 LP 510/40 BP V510

L 17 465 LP 470/15 BP V470

M 30 430 LP 450/40 BP V450

N 29 415 LP 427/25 BP V427
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Laser Detector Channel Mirror Filter Parameter

UV (355 nm) A 40 765 LP 809/32 BP UV809

B 39 704 LP 736/64 BP UV736

C 38 675 LP 695/40 BP UV695

D 37 645 LP 660/30 BP UV660

E 36 595 LP 610/30 BP UV610

F 35 570 LP 585/30 BP UV585

G 34 535 LP 540/20 BP UV540

H 33 495 LP 515/60 BP UV515

I 32 425 LP 446.5/67 BP UV446

J 31 365 LP 379/34 BP UV379

Yellow-Green (561 nm) A 49 800 LP 825.5/49 BP YG825

B 48 750 LP 780/60 BP YG780

C 47 735 LP 750/40 BP YG750

D 46 699 LP 730/50 BP YG730

E 45 680 LP 695/40 BP YG695

F 44 665 LP 670/20 BP YG670

G 43 645 LP 660/30 BP YG660

H 42 595 LP 602/40 BP YG602

I 41 570 LP 585/30 BP YG585

Chapter 5  Spectral Functions 51



The following table contains a list of common dyes and the primary or secondary detector parameters to use
with them. When using multiple single-color fluorochrome controls, each control should be assigned to a
detector not used by any of the other single-color controls. When possible, assign each control to its primary
detector. If two controls that you are using share the same primary detector, assign one of them to a secondary
detector instead.

Dye Primary Secondary Dye Primary Secondary

Alexa Fluor 488 B537 – BUV805 UV809 –

Alexa Fluor 647 R675 – BV421 V427 –

Alexa Fluor 700 R730 R710 BV480 V470 –

APC R675 R680 BV510 V510 –

APC-Cy7 R780 YG780 BV570 V576 –

APC-H7 R780 YG780 BV605 V595 –

APC-R700 R710 – BV650 V660 –

BB515 B510 B537 BV711 V710 –

BB630 B602 – BV750 V750 –

BB660 B660 – BV786 V785 –

BB700 B710 B750 FITC B510 B537

BB755 B750 – PE YG585 –

BB790 B810 – PE-CF594 YG602 –

BUV395 UV379 – PE-Cy5 YG660 –

BUV496 UV515 – PE-Cy7 YG780 –

BUV563 UV585 – PerCP B675 –

BUV615 UV610 – PerCP-Cy5.5 B710 B750

BUV661 UV660 – R718 R730 R710

BUV737 UV736 – V450 V450 –

Autofluorescence
Autofluorescence is the intrinsic fluorescent signal produced by a cell when stimulated by lasers. It is present to
some extent on all particles, and varies from cell type to cell type (for example, monocytes have a different
autofluorescence spectrum than lymphocytes). Spectral unmixing can be used to extract the autofluorescence
spectrum of the cells of interest in your experiment and to separate this intrinsic fluorescent signal from the
signal emitted by the fluorochromes in your experiment.

The autofluorescence control is the "single-stained" control for the autofluorescence in the experiment. In a
spectral experiment, autofluorescence is unmixed as if it were another fluorochrome in your experiment. The
autofluorescence control must use the same cell type as your fully stained sample. The other single-stained
controls are not constrained in this way. For example, beads could be used for the other single-stained controls,
but not for the autofluorescence control.
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To add an autofluorescence control, see Setting up a new spectral experiment (page 53).

Spectral unmixing software considerations
When you perform spectral unmixing in BD FACSDiva™ software, you can also view compensated (non-spectral)
data in that software.

Caution!

Do not delete any fluorescent parameters. Doing so will remove the ability of the BD FACSymphony™ A5 SE flow
cytometer to perform spectral unmixing.

For each reagent in your experiment, you will need to select a “primary” detector, typically the detector that
overlaps or is closest to that fluorochrome's main emission peak on its primary exciting laser. These detectors will
serve as the “conventional” detectors for each fluorochrome in compensation mode, and will also be used for
gating to define positive populations in your single-stained controls. Labeling the parameter is necessary for
spectral unmixing in BD FACSDiva™. See the tables in Spectral function overview (page 48) for information
about the parameters and the primary parameters associated with some commonly used commercial dyes.

Setting up a new spectral experiment
The following procedure references buttons on the Workspace toolbar in BD FACSDiva™. These are:
l Browser
l Cytometer
l Inspector
l Worksheet
l Acquisition Dashboard

When you add elements or make selections in the Browser, the Inspector displays details, properties, and options
that correspond to your selection.

1. Create a new experiment and rename it:
a. Click Browser in the Workspace toolbar.

b. Click the New Folder button in the Browser toolbar.

c. Click the folder and rename it.

d. With the renamed folder still selected, click the New Experiment button on the Browser toolbar.

e. Click the new experiment entry in the Browser and rename it

2. Create a new specimen by clicking the New Specimen button on the Browser toolbar and rename it.
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3. Verify that the base configuration, FACSymphony A5 SE Default Configuration, is selected as described in
Verifying the configuration and user preferences (page 65).

Note: Spectral experiments must use the base configuration. Custom configurations may only be used in
compensation workflows.

4. Navigate to Experiment > Experiment Layout and assign parameter labels for each reagent to an individual
primary detector. Typically, both the dye and the antibody names are added to the label, as shown in the
following example. To add an autofluorescence control to your experiment, assign the label "AutoF" to
parameter UV446. If that parameter is already assigned to another fluorochrome in your experiment, select
any of parameters UV379–UV540 or V427–V540 for AutoF.

Note: The “AutoF” label is case-sensitive. The autofluorescence control is only supported in spectral
workflows, not compensation workflows.

5. Adjust the flow cytometer settings as needed for your experiment, including and PMT voltage and area
scaling.

Note: For spectral experiments, create a spectral plot to assist with adjusting PMT voltage settings. Using a
spectral plot lets you ensure that the signal across all detectors is on-scale, not just the signal for the primary
detector for each fluorochrome. For details about spectral plots, see the note at the end of this procedure.

l For details about adjusting PMT voltage settings for the unstained sample and single-color control tubes,
see Creating application settings (page 72).

l For details about adjusting area scaling, see Adjusting area scaling (page 90).

6. Set the Current Tube Pointer to the previously created sample tube with labeled parameters.

7. Create any plots, gates, and statistics needed for data analysis. For details, refer to the BD FACSDiva™
Software Reference Manual.

Note: In addition to the dot and density plots, contour plots, and histogram plots for single-parameter data
used in compensation cytometry, the BD FACSymphony™ A5 SE flow cytometer features the ability to create
spectral plots, where the plot shows combined color-coded histograms of all raw detector values. The icon on
the worksheet toolbar for creating a spectral plot is outlined in red in the following illustration:
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The detector names displayed along the x-axis are formed by combining the first character of the laser color
with the center value of the filter bandpass range for that detector.

The plot supports the display of specific populations or combinations of populations, and displays live data
during acquisition. Density color schemes or color by population can be modified in the inspector window
when the plot is selected.

The spectral plot does not support zoom, biexponential scaling, or gate drawing.
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Setting up the Spectral Unmixing algorithm
1. With the Current Tube Pointer to the previously created sample tube with labeled parameters, select

Experiment > Compensation Setup > Create Compensation Controls from the main menu.

2. Leave the checkbox Include Generic in its default (deselected) state.

3. Click OK to create the controls. This adds the controls to the experiment Browser window, under
Compensation Controls, and creates a tab for each control on the worksheet. If you assigned AutoF to a
detector in the experiment layout, an AutoF control tube will display here too, as shown in the following
example.

4. If you have a separate tube for your unstained control, record the unstained control as follows:

a. Select the Unstained Control tab on the worksheet.

b. In the experiment Browser, set the run pointer onUnstained Control.

c. On the Acquisition Dashboard, click Acquire Data.
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d. Move the P1 gate to cover the events of interest.

e. (Optional) Right-click the gate and select Apply to All Compensation Controls from the context menu.

f. In the Acquisition Dashboard, click Record Data.

The acquisition and recording automatically stops when the number of events in the Events to Record list
box is reached (default value is 5000 events).

5. Record each of the single-color controls as follows:

a. Load the single-color control tube. If you are using an autofluorescence control in your experiment, record
your autofluorescence tube using your unstained cell sample.

b. Select the tab for the single-color control on the worksheet.

c. In the experiment Browser, set the run pointer on the corresponding control.

d. On the Acquisition Dashboard, click Acquire Data.

e. If necessary, move the P1 gate on the left dot plot to include the events of interest.

f. In the Acquisition Dashboard, click Record Data.

g. When the recording completes, remove the control tube.

h. If necessary, adjust the position and width of the P2 gate to span the positive population on the
histogram plot.

6. Select Experiment > Compensation Setup > Calculate Spectral Unmixing.
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The screen displays the Single Stained Setup dialog.

7. Enter a name for the setup and click Link & Save.

When the software calculates spectral unmixing, it also calculates compensation values (as if you had selected
Experiment > Compensation Setup > Calculate Compensation). Compensation setup does not take
autofluorescence into account. By default, when you select spectral unmixing, Spectral is selected in the
dropdown menu on the Compensation panel of the Cytometer window as shown in the following example:
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You can elect to switch between spectral unmixed and traditional compensation values, by toggling between
Spectral and Compensated in the dropdown menu, to compare the plot data in each case.

Recording and analyzing spectral data
1. If needed, with the specimen tube selected, create more plots, gates, and statistics in addition to those

created when initially setting up the experiment.

2. Record sample data using the initial tube.
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3. To acquire and record more tubes, click Next Tube and/or Duplicate the Specimen. Tubes must have the
same parameter labels as was set up in the Spectral Unmixing algorithm by the Create Compensation
Controlsmenu command.

When the software calculates spectral unmixing, it also calculates compensation values (as if you had
selected Experiment > Compensation Setup > Calculate Compensation). Compensation setup does not take
autofluorescence into account. By default, when you select spectral unmixing, the Spectral settings are
selected in the dropdown menu on the Compensation panel of the Inspector window as shown in the
following example:

You can elect to switch between spectral unmixed and traditional compensation values, by toggling between
Spectral and Compensated in the dropdown menu, to compare the plot data in each case.
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4. To export spectral BD FACSDiva™ FCS files, select the file or files to export, right-click and select Export
> FCS Files.

Caution!

When exporting data to an FCS file, the exported data will reflect the setting applied in the dropdown control
on the Compensation panel. Thus, if Compensated is selected in the dropdown menu, traditional
compensation data will be exported, even if spectral unmixing was selected during compensation setup. To
export spectral unmixed data, make sure that Spectral is selected in the Compensation panel.

5. To export an experiment from the browser with all data included, click the Browser button in the Workspace
toolbar to open the browser. Right-click the experiment in the browser and select Export > Experiment.

6. If you want to repeat this experiment later, create an experiment template. For instructions about how to do
this, refer to the BD FACSDiva™ Software Reference Manual.

7. Delete experiments in the Browser panel as required.

Repeating a spectral experiment
To repeat an experiment, you need to create a new experiment using an experiment template and set its
properties so they are the same as the experiment you want to repeat. For instructions about how to create an
experiment template, refer to the BD FACSDiva™ Software Reference Manual.
1. In the Browser, select a location to create the new experiment. If desired, create a new folder (from the

menu bar, select Experiment > New Folder) and rename it.

2. From the menu bar, select Experiment > New Experiment.
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The Experiment Templates dialog is displayed.

3. In the tab containing the experiment template that you want to load, select the template and click OK.

4. Confirm the parameters and labels are correct for the assay that you want to repeat.

5. Set up the spectral unmixing algorithm as described in Setting up the Spectral Unmixing algorithm (page 56).

6. Record and analyze spectral data as described in Recording and analyzing spectral data (page 59).
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Optimizing cytometer settings
This chapter covers the following topics:
l Cytometer settings workflow (page 64)
l Verifying the configuration and user preferences (page 65)
l Running a performance check (page 67)
l Setting up a compensation experiment (page 69)
l Creating application settings (page 72)
l Recording compensation controls (page 73)
l Calculating compensation (page 76)



Cytometer settings workflow

Introduction

This topic describes how to optimize cytometer settings. The optimization is performed using the
BD® Cytometer Setup Software, Application Settings, and Compensation Setup features of BD FACSDiva™
software.

When to optimize settings

Before you record data for a sample, optimize the cytometer settings for the sample type and fluorochromes
used.

Manual compensation

Compensation setup automatically calculates compensation settings. If you choose to perform compensation
manually, not all of the following instructions apply. For detailed instructions, see the BD FACSDiva™ Software
Reference Manual.

First-time users

If you are performing the procedures in this workflow for the first time, you should be familiar with
BD FACSDiva™ software concepts: workspace components, cytometer and acquisition controls, and tools for
data analysis.

For additional details, see the BD FACSDiva™ Software Reference Manual.

Before you begin

Start the cytometer and perform the setup and QC procedures. See Cytometer setup (page 23).

Workflow for optimizing settings

Cytometer optimization consists of the following steps.

Step Description

1 Verifying the configuration and user preferences (page 65)

2 Running a performance check (page 67)

3 Setting up a compensation experiment (page 69)

4 Creating application settings (page 72)

5 Recording compensation controls (page 73)

6 Calculating compensation (page 76)

Note: Application settings are optional and do not have to be saved for the experiments. However, they are
useful for optimizing cytometer settings.
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About the examples

The examples in this chapter use a 4-color bead sample with the following fluorochromes:
l FITC
l PE
l PerCP-Cy5.5
l APC

If you follow this workflow with a different bead sample (or another sample type), your software views, data
plots, and statistics might differ from the example. Additionally, you might need to modify some of the
instructions in the procedure.

The information shown in italics is for example only. You can substitute your own names for folders and
experiments.

Verifying the configuration and user preferences

Introduction

This topic describes how to verify the cytometer configuration and user preferences before you create an
experiment.

Caution! To obtain accurate data results, the current cytometer configuration must reflect your flow cytometer
optics.
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Procedure

To verify the configuration and preferences before you create an experiment:
1. Select Cytometer > View Configurations and verify the current configuration.

Your cytometer might include only the base configuration when your cytometer is installed. This
configuration must always be used for spectral cytometery workflows. For compensation cytometry
workflows, you can create custom configurations later as needed.

2. If you need to select a configuration other than the current configuration:
a. In the Configurations tab, select a configuration.
b. Click Set Configuration.
c. Click OK.
d. Verify that the configuration you just set matches your flow cytometer optics.

3. Click OK to close the Cytometer Configurationwindow.
4. Select File > Exit to close CS&T.
5. If the CST Mismatch dialog opens, click Use CST Settings.
6. Select Edit > User Preferences.
7. Click the General tab and select the Load data after recording checkbox.
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See theBD FACSDiva™ Software Reference Manual for more information about cytometer configurations and
user preferences.

Next step

Running a performance check (page 67)

More information
l Setting up a compensation experiment (page 69)

Running a performance check

Introduction

This topic describes how to run a performance check as part of quality control.

Overview

The CS&T application is designed to monitor performance on a daily basis and to optimize laser delay.

Running a performance check on a regular basis provides a standard for monitoring changes in performance due
to degradation of laser power, aging of PMTs, and other potential cytometer service issues. Performance results
are also affected by fluidics performance. We strongly recommend following the fluidics maintenance
procedures as described in Cleaning the fluidics (page 37).

Considerations

Some BP filters might not be normalized to CS&T settings. In this case, CS&T will generate Qr and Br numbers
that are not comparable from instrument to instrument. They are however, still trackable on one cytometer. Part
of the process for optimizing cytometer settings includes verifying PMT voltages set by CS&T for all parameters.

Before you begin

Define the performance baseline for any configuration before running a performance check. See Custom
configurations and baselines (page 34).

Procedure

To run a performance check:
1. Select Cytometer > CST.
2. Verify that the bead lot information under Setup Beadsmatches the Cytometer Setup and Tracking bead

lot.

3. Verify that the cytometer configuration is correct for your experiment.
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If the cytometer is not set to the correct configuration:
a. Click Select Configuration in the Setup Controlwindow.
b. Select the correct configuration from the list.
c. Click Set Configuration and then click OK.

4. Verify that the current configuration has a valid baseline defined.
If not, see the BD Cytometer Setup and Tracking Application Guide for more information on defining a
baseline.

5. Prepare the CS&T beads according to the technical data sheet provided with the beads or available on the
BD Biosciences website (bdbiosciences.com).

6. Install the bead tube onto the SIP.
7. In the Setup Controlwindow, select Check Performance from the Characterizemenu.

8. Click Run.
9. On the fluidics control panel, ensure that FINE Adj is set to 250, then press the RUN and LOW buttons.

Plots appear under the Setup tab and the performance check is run. The performance check takes
approximately 5 minutes to complete.

10. Once the performance check is complete, click View Report.
11. Verify that the cytometer performance passed.

In the Setup tab, the cytometer performance results should have a green checkbox displayed and the word
Passed next to it.
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If any parameters did not pass, see the BD Cytometer Setup and Tracking Application Guide for
troubleshooting information.

12. Select File > Exit to close the CS&T window and return to the BD FACSDiva™ interface.
The CSTMismatch dialog opens.

Click the Details button to verify which cytometer settings will be updated.
13. Click Use CST Settings.

By selecting Use CST Settings, the laser delay, area scaling, and other cytometer settings will be updated to
the latest settings from the performance check.

Setting up a compensation experiment

Introduction

This topic describes how to create an experiment in a new folder, specify the parameters of the experiment, and
add compensation tubes.

Creating an experiment

To create an experiment:
1. Click the buttons on theWorkspace toolbar to display the following windows as needed:

l Browser
l Cytometer
l Inspector
l Worksheet
l Acquisition Dashboard
When you add elements or make selections in the Browser, the Inspector displays details, properties, and
options that correspond to your selection.

2. Click the New Folder button on the Browser toolbar to add a new folder.
3. Click the folder and rename itMyFolder.
4. ClickMyFolder, then click the New Experiment button on the Browser toolbar.
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a. Click the new experiment in the Browser and rename itMyExperiment.
5. Select MyExperiment in the Browser.

The Inspector displays details for the experiment.

Specifying parameters

To specify the parameters for the new experiment:
1. Select Cytometer Settings for the experiment in the Browser.

Cytometer settings appear in the Inspector.

2. Make sure the parameters you need appear on the Parameters tab in the Inspector.
a. Click a Parameter name to display the available fluorochromes in the Parameters list.
b. Select the specific parameter from the menu. Your selection appears as the selected parameter.
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c. For this example, select FITC from the menu.

3. Delete any unnecessary parameters.

Note: Unnecessary parameters may only be deleted when running in compensation mode.
a. Click the selection button (to the left of the parameter name) to select the parameter.
b. Click Delete.

The parameter is deleted.
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Creating application settings

Introduction

This topic describes how to create application settings.

About application settings

Application settings are associated with a cytometer configuration and include the parameters for the
application, area scaling values, PMT voltages, and threshold values, but not compensation. Each time a
performance check is run for a configuration, the application settings associated with that configuration are
updated to the latest run.

Using application settings provides a consistent and reproducible way to reuse cytometer settings for commonly
used applications.

You can include area scaling adjustment in your application settings. See Adjusting area scaling (page 90) for
more information.

Before you begin

Perform the cytometer setup procedure and run a performance check for the configuration that will be used for
the application.

Procedure

To create application settings:
1. In the open experiment, right-click Cytometer Settings in the Browser, then select Application Settings >

Create Worksheet.
A second global worksheet is added with the plots created according to the selections in the Parameters tab.

Use the gray boxes and crosshairs to guide your optimization.

2. Create a new specimen and tube.
3. Load the unstained control tube onto the cytometer.
4. In the Cytometer window, optimize the PMT voltages for the application.

l Optimize the FSC and SSC voltages to place the population of interest on scale.
l Optimize the FSC threshold value to eliminate debris without interfering with the population of interest.
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l If needed, increase the fluorescence PMT voltages to place the negative population within the gray
boxes. Align the center of the negative population with the crosshair visible in the gray box.

Note: Do not decrease the fluorescence PMT voltages. Doing so can make it difficult to resolve dim
populations from the negative population.

5. Unload the unstained control tube from the cytometer.
6. Load the multicolor sample onto the cytometer or load a single-color control tube.
7. Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT voltage for that parameter until the positive population
can be seen entirely on scale.

8. Unload the multicolor sample or single-color control tube.
9. If working with single-color control tubes, repeat steps 6–8 for every control tube to verify each fluorochrome

signal separately.
10. Place a tube containing DI water on the SIP and put the cytometer on standby.
11. Save the application settings by right-clicking Cytometer settings in the Browser, then selecting Cytometer

Settings > Save.
12. In the Save Cytometer Settings dialog, enter a descriptive name for the settings.

13. Click OK.
The application settings are saved to the catalog.

Next step

Recording compensation controls (page 73)

Recording compensation controls

Introduction

This topic describes how to create and record compensation controls using the Compensation Setup feature of
BD FACSDiva™ software and an experiment with optimized settings.

Creating compensation tubes

To create compensation control tubes:
1. Select Experiment > Compensation Setup > Create Compensation Controls.

The Create Compensation Controls dialog opens.
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2. Set or clear the Include separate unstained control tube/well and/or Include Generic checkboxes as needed.
Select Include Generic when running generic controls (not label-specific compensation). Select Include
separate unstained control tube when preparing an unstained control in a separate tube (as opposed to
being in the same tube as the single-stained control).

3. Click OK.
Compensation control tubes are added to the experiment. Worksheets containing appropriate plots and
gates are added for each compensation tube.

Recording compensation settings

To record compensation settings:
1. Press RUN and HIGH on the cytometer fluid control panel.
2. Install the unstained control tube onto the SIP.
3. Expand the Compensation Controls specimen in the Browser.
4. Set the current tube pointer to the unstained control tube (it becomes green), then click Acquire Data in the

Acquisition Dashboard.
5. Verify that the population of interest is displayed appropriately on the FSC vs SSC plot and adjust voltages if

necessary.
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6. Adjust the P1 gate to surround only the singlets.
7. Right-click the P1 gate and select Apply to All Compensation Controls.

The P1 gate on each stained control worksheet is updated with your changes.
8. Click Record Data.
9. When recording is finished, remove the unstained control tube from the cytometer.
10. Click Next Tube.

Caution! Do not change the PMT voltages after the first compensation control has been recorded. In order to
calculate compensation, all controls must be recorded with the same PMT voltage settings. If you need to
adjust the PMT voltage for a subsequent compensation control, you must record all compensation controls
again.

11. Install the next tube onto the cytometer and repeat steps 8 through 10 until data for all stained control
tubes has been recorded.

12. Double-click the first stained control tube to display the corresponding worksheet.
13. Verify that the snap-to interval gate encompasses the positive population.

14. Repeat steps 12 and 13 for the remaining compensation tubes.

Next step

After you have recorded data for each single-stained control, calculate compensation as described in Calculating
compensation (page 76).
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Calculating compensation

Introduction

This topic describes how to calculate compensation.

Before you begin

Before you can calculate compensation, you need to record the data for each single-stained control.

Procedure

To calculate compensation:
1. Select Experiment > Compensation Setup > Calculate Compensation.

Note: If the calculation is successful, a dialog prompts you to enter a name for the compensation setup. The
default name is year/month/day/time.

2. Enter a setup name and click Link & Save.
The compensation is linked to the cytometer settings and saved to the catalog.
To help track compensation setups, include the experiment name, date, or both in the setup name.
The compensation setup is linked to theMyExperiment cytometer settings, and subsequent acquisitions in
MyExperiment are performed with the new compensation settings.

We recommend that you always visually and statistically inspect automatically calculated spectral overlap
values. The means of the positive controls should be aligned with the means of the negative controls.

More information
l Recording compensation controls (page 73)
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Recording and analyzing data
This chapter covers the following topics:
l Data recording and analysis workflow (page 78)
l Preparing the workspace (page 78)
l Recording data (page 79)
l Analyzing data (page 81)
l Reusing an analysis (page 84)



Data recording and analysis workflow

Introduction

This topic outlines the basic acquisition and analysis tasks using BD FACSDiva™ software.

About the examples

The examples in this chapter are from two 4-color bead samples with the following fluorochromes:
l FITC
l PE
l PerCP-Cy5.5
l APC

If you use a different sample type or if you have skipped the optimization steps in Optimizing cytometer
settings (page 63), your software window content, names of folders and experiments, and your data plots and
statistics might differ from those shown here. You might also need to modify some of the instructions in the
procedure.

For additional details on completing some of the following steps, see the BD FACSDiva™ Software Reference
Manual.

This procedure builds on the results obtained in Optimizing cytometer settings (page 63).

Workflow for recording and analyzing data

Recording and analyzing data consists of the following steps.

Step Description

1 Preparing the workspace (page 78)

2 Recording data (page 79)

3 Analyzing data (page 81)

4 Reusing an analysis (page 84)

Preparing the workspace

Introduction

This topic describes how to prepare the workspace and apply application settings to your experiment before
recording data.

Procedure

To prepare the workspace:
1. Using the Browser toolbar, create a new specimen inMyExperiment and rename it FourColorBeads.
2. Create two tubes for the FourColorBeads specimen. Rename the tubes Beads_001 and Beads_002.
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3. Expand the Global Worksheets folder inMyExperiment to access the default global worksheet, and rename
the worksheet MyData.

4. On theMyData worksheet, create the following plots for previewing the data:
l FSC vs SSC
l FITC vs PE
l FITC vs PerCP-Cy5.5
l FITC vs APC

Applying saved application settings to a new experiment

When applications settings are applied to an experiment, the cytometer settings are updated with the
parameters included in the application settings, optimized PMT voltages, threshold settings, area scaling factors,
and window extension values.

To apply saved application settings to your experiment:
1. Right-click the experiment-level Cytometer Settings and select Application Settings > Apply.
2. In the Application Settings catalog, select the application settings file you saved previously and click Apply.

If the parameters are not the same, a mismatch dialog opens.
l Click Overwrite to update all settings.
l Click Apply to change only the common parameters.
For more information, see the BD FACSDiva™ Software Reference Manual.

The cytometer settings are renamed application settings and the cytometer settings icon in the Browser
changes.

More information
l Creating application settings (page 72)
l Recording data (page 79)

Recording data

Introduction

This topic provides an example of how to preview and record data for multiple samples.

Before you begin

Prepare the sample tubes.

Note: If you need to run samples at an event rate greater than 10,000 events/second, consider changing your
Window extension. See the BD FACSDiva™ Software Reference Manual for more information.

Recording data

To record data:
1. Press RUN and HIGH on the cytometer fluid control panel.
2. Install the first sample tube onto the SIP.
3. Set the current tube pointer to Beads_001.
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4. Click Acquire Data in the Acquisition Dashboard to begin acquisition.
5. While data is being acquired:

a. Draw a gate around the singlets on the FSC vs SSC plot.
b. Rename the P1 gate to Singlets.
c. Use the Inspector to set the other plots to show only the singlet population by selecting the Singlets

checkbox.

6. Click Record Data.
7. When event recording has completed, remove the first tube from the cytometer.

TheMyData worksheet plots should look like the following.

8. Install the second sample tube onto the SIP.
9. Set the current tube pointer to Beads_002.
10. Click Acquire Data to begin acquisition.
11. Before recording, preview the data on theMyData worksheet to verify that all expected populations are

visible and the data is similar to the previous sample.
12. Click Record Data.
13. When event recording has completed, remove the second tube from the cytometer.
14. If you are recording more than two tubes, repeat steps 8 through 13 for the remaining tubes.
15. Print the experiment-level cytometer settings by right-clicking the Cytometer Settings icon in the Browser

and selecting Print.
16. Install a tube of DI water onto the SIP.
17. Place the cytometer in standbymode.
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More information
l Analyzing data (page 81)

Analyzing data

Introduction

This topic describes how to analyze recorded tubes by creating plots, gates, a population hierarchy, and statistics
views on a new global worksheet.

Analyzing data

To analyze data:
1. Use the Browser toolbar to create a new global worksheet. Rename itMyDataAnalysis.
2. Create the following plots on theMyDataAnalysis worksheet:

l FSC vs SSC
l FITC vs PE
l FITC vs PerCP-Cy5.5
l FITC vs APC

3. Create a population hierarchy and a statistics view, and set them below the plots on the worksheet.
l Right-click any plot and select Show Population Hierarchy.
l Right-click any plot and select Create Statistics View.

4. Set the current tube pointer to Beads_001.
5. Draw a gate around the singlets on the FSC vs SSC plot.
6. Use the population hierarchy to rename the population Singlets.
7. Select all plots except the FSC vs SSC plot, and use the Plot tab in the Inspector to show only the singlet

population.
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8. Select all plots, and click the Title tab in the Inspector.
9. Select the Tube and Populations checkboxes to display their names in plot titles.

10. On all fluorescence plots:
l Make all plots biexponential. Select all fluorescence plots and select the X Axis and Y Axis checkboxes in

the Plot tab of the Inspector.
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l In the FITC vs PE plot, draw a gate around the FITC-positive population. Name the population FITC
positive in the population hierarchy.

l In the FITC vs PE plot, draw a gate around the PE-positive population. Name the population PE positive in
the population hierarchy.

l In the FITC vs PerCP-Cy5.5 plot, draw a gate around the PerCP-Cy5.5-positive population. Name the
population PerCP-Cy5.5 positive in the population hierarchy.

l In the FITC vs APC plot, draw a gate around the APC-positive population. Name the population APC
positive in the population hierarchy.

11. Format the statistics view.
a. Right-click the statistics view and select Edit Statistics View.
b. Click the Header tab and select the SpecimenName and Tube Name checkboxes.
c. Click the Populations tab and select all populations except All Events. Clear the %Parent, %Total, and

#Events checkboxes.
d. Click the Statistics tab and select the mean for each of the fluorescence parameters.

e. Click OK.
12. Print the analysis.

Your global worksheet analysis objects should look like the following.
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More information
l Reusing an analysis (page 84)

Reusing an analysis

Introduction

This topic describes how to use global worksheets to apply the same analysis to a series of recorded tubes. Once
you define an analysis for a tube, you can use it to analyze the remaining tubes in the experiment. After viewing
the data, print the analysis or save it to a normal worksheet.

Reusing an analysis

To reuse the analysis:
1. Set the current tube pointer to the Beads_002 tube.
2. View the Beads_002 data on your analysis worksheet. Adjust the gates as needed.
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Adjustments apply to subsequent tubes viewed on the worksheet. To avoid altering a global worksheet, save
an analysis to a normal worksheet, then make adjustments on the normal worksheet.

3. Print the analysis.

Saving the analysis

When you perform analysis with a global worksheet, the analysis does not save with the tube.

If you define your analysis on a global worksheet before recording data, you can specify to automatically save
the analysis after recording data. You set this option in User Preferences.

To save a copy of the analysis with a tube:
1. Expand theMyDataAnalysis global worksheet icon in the Browser.
2. Right-click its analysis and select Copy.

3. Click theWorksheets View button on the Worksheet toolbar to switch to the normal worksheet view.
4. SelectWorksheet > New Worksheet to create a new normal worksheet.
5. Right-click the Beads_001 tube icon in the Browser, and select Paste.

The analysis objects from theMyDataAnalysis global worksheet are copied to the Beads_001_Analysis
normal worksheet. Double-click the Beads_001 tube in the Browser to view the analysis.

Applying an analysis to normal worksheets

You can apply the global worksheet analysis to multiple tubes (on a single normal worksheet) by selecting
multiple tubes before pasting the analysis. Ensure that you collapse all tube elements in the Browser before you
paste them to multiple tubes.

More information
l Analyzing data (page 81)
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Manual settings
This chapter covers the following topics:
l About laser delay (page 88)
l Optimizing laser delay (page 88)
l Adjusting area scaling (page 90)



About laser delay

Introduction

This topic describes how to manually set the laser delay if you are not using CS&T for cytometer setup and
tracking.

About laser signal delay

Sample interrogation takes place within the cuvette flow cell. Laser light is directed through a series of prisms
that focus multiple lasers on the event stream at different positions. This allows optimal detection of
fluorescent signals from each laser with minimal cross-contamination from the other beams.

Because the laser signals are spatially separated, there is a slight delay between the detection of each laser’s
signal.

Time

5

4

3

1

2

Item Number Laser Delay

1 Red laser (longest) delay

2 Yellow-green laser delay

3 Blue laser delay

4 Violet laser delay

5 UV laser (shortest) delay

The laser delay setting in BD FACSDiva™ software is used to re-align the signals so they can be measured and
displayed on the same time scale. Signals are aligned with respect to the blue laser, so the blue laser will have a
0 delay value, the red laser will have negative delay compensation, and the UV laser will have positive delay
compensation.

Optimizing laser delay

Introduction

This topic describes how to optimize the laser delay using BD FACSDiva™ software.
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Before you begin

To optimize the delay for a given laser, you must acquire events from a sample with a fluorescence signal
excited by that laser. Follow the procedures in Recording and analyzing data (page 77), for sample optimization
and acquiring data.

Procedure

To optimize laser delay:
1. While acquiring data from your sample, create a histogram to show the fluorescence signal excited by the

laser for which the delay is to be optimized.
2. In the Acquisition Dashboard, set the Events to Display to 500 events.
3. Click the Laser tab in the Cytometer window.

Window extension and laser delay values are displayed in microseconds (µs).

4. Set theWindow Extension value to 0 µs.
5. Set an initial laser delay value only for the laser you are optimizing.

l If you are optimizing the violet laser, set its delay to –35 µs.
l If you are optimizing the UV laser, set its delay to –65 µs.
l If you are optimizing the red laser, set its delay to 65 µs.
l If you are optimizing the blue laser, set its delay to 0 µs.
l If you are optimizing the yellow-green laser, set its delay to 35 µs.

6. While observing the positive events on the histogram, adjust the laser delay in 1-µs increments. You might
need to adjust the delay above or below the initial setting.
Choose the setting that moves the events farthest to the right (highest fluorescence intensity).

7. Draw an interval gate on the histogram for the positive events.
8. Create a statistics view to display the mean fluorescence intensity (MFI) of the gated population.
9. While observing the MFI for the gated population, adjust the laser delay in 0.1-µs increments within a range

of 2.0 µs of the setting obtained in While observing the positive events on the histogram, adjust the laser
delay in 1-µs increments. You might need to adjust the delay above or below the initial setting. (page 89).
Preserve the setting that maximizes the fluorescence intensity.

10. Reset theWindow Extension to 10 µs.

Chapter 8  Manual settings 89



Adjusting area scaling

Introduction

This topic describes how to manually adjust the area scaling on your cytometer if necessary for your application.
The area scaling is automatically set in CS&T. Depending on the size of your target particle, you might need to
adjust the area scaling manually. Larger particles are more likely to require an area scaling adjustment.

About area scaling

The area of a pulse is calculated by BD FACSDiva™ using measured height and width measurements. It is
sometimes important to verify that the area calculation and the height measurement are equivalent by
adjusting the factor applied to the area. The required area scaling factor changes based on sheath pressure and
particle size.

About this example

The following example describes how to adjust area scaling for an experiment which uses only the 488-nm laser
and the 640-nm laser. You must adjust area scaling for all lasers used in your experiment. To adjust the other
lasers, add a parameter and the corresponding plots from that laser to the procedure.

Procedure

To adjust area scaling:
1. Open an existing experiment, or create a new experiment in the Browser.
2. Create a new specimen by clicking the New Specimen button on the Browser toolbar.
3. In the Inspector, click the Parameters tab and select the H checkbox to select the height for each

parameter.
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4. On the global worksheet, create the following plots and histograms:
l FSC vs SSC dot plot
l FSC-H and FSC-A histogram
l FITC-H and FITC-A histogram
l APC-H and APC-A histogram

5. Create a P1 gate in the FSC vs SSC plot, and show only the P1 population in all histograms.
6. Create three statistic views showing the following:

l FSC-H and FSC-A means for P1
l FITC-H and FITC-A means for P1
l APC-H and APC-A means for P1
Your worksheet should look similar to the following figure.
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7. Expand the new specimen, then set the current tube pointer to tube_001.
8. Install the FITC-positive control tube onto the loading port and click Load in the Acquisition Dashboard.
9. Adjust the FSC and SSC voltages to place the particles on scale.

10. Adjust the P1 gate around the population of interest.
11. Adjust the FSC area scaling.

a. Click the Laser Tab in the Cytometer window.
b. Adjust the FSC area scaling factor until the FSC-A signal matches the FSC-H signal:
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l Increase the area scaling factor if the FSC-A signal is lower than FSC-H.
l Decrease the area scaling factor if the FSC-A signal is higher than FSC-H.

c. View the result of your change in the histograms and statistics views.
12. Adjust the blue laser area scaling factor until the FITC-A signal matches the FITC-H signal, if needed.
13. Unload the FITC-positive control tube, then load the APC-positive control tube.
14. Adjust the red laser area scaling factor until the APC-A signal matches the APC-H signal, if needed.
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Troubleshooting
This chapter covers the following topics:
l Cytometer troubleshooting (page 96)
l Electronics troubleshooting (page 101)



Cytometer troubleshooting

Introduction

This topic describes possible problems and recommended solutions for BD FACSymphony™ A5 SE flow cytometer
issues.

Droplets are visible on the SIP

Possible causes Recommended solutions

Worn O-ring in the retainer Replace the O-ring. See Changing the sample tube O-ring (page 44).

Outer sleeve is not seated in the retainer 1. Loosen the retainer.

2. Push the outer sleeve up into the retainer until seated.

3. Tighten the retainer.

Outer sleeve is not on the sample injection
tube

Replace the outer sleeve.

1. Loosen the retainer.

2. Slide the outer sleeve over the sample injection tube until it is seated.

3. Tighten the retainer.

Waste line is pinched, preventing proper
aspiration

Check the waste line.

Waste tank is full Empty the waste tank.

Droplet containment vacuum is not
functioning

Call your BD service representative.

The mode is not set to HTS. Change the mode to HTS by pressing down the Mode button for more than
3 seconds.

Sample tube not fitting on SIP

Possible causes Recommended solutions

Sample tube other than Falcon® tubes used Use Falcon® 12 x 75-mm sample tubes. See Equipment (page 105).

Worn Bal seal Replace the Bal seal. See Changing the Bal seal (page 42).

Sample tube is cracked Transfer contents to a new tube.

Rapid sample aspiration

Possible causes Recommended solutions

Support arm is to the side Place the support arm under the sample tube.

Droplet containment
module is failing

Try the solutions in Droplets are visible on the SIP (page 96). If the issue is not resolved, call
your BD service representative.
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No events in acquisition display and RUN button is green

Possible causes Recommended solutions

Threshold is not set to the
correct parameter (usually FSC)

Set the threshold to the correct parameter for your application.

Threshold level is too high Lower the threshold level.

PMT voltage for threshold
parameter is set too low

Set the PMT voltage higher for the threshold parameter.

Gating issue See the BD FACSDiva™ Software Reference Manual for information on setting gates.

Air in the sheath filter Purge the filter. See Removing air bubbles (page 27).

Air bubble or debris in the flow
cell

Prime the fluidics system. See Preparing the fluidics (page 31).

No sample in the tube Verify that sample remains in the tube and if necessary, add sample to the tube or
install a new sample tube.

Sample is not mixed properly Mix the sample to suspend the cells.

Waste tank is full Empty the waste tank.

PMT voltages set too low or too
high for display parameter

Adjust the PMT voltages.

Too few events are displayed Increase the number of events to display.

Sample injection tube is clogged Remove the sample tube to allow backflushing.

If the event rate is still erratic, clean the sample injection tube. See Cleaning the
fluidics (page 37).

Bal seal is worn Replace the Bal seal. See Changing the Bal seal (page 42).

Instrument is not warmed up Wait 30 minutes for the instrument to warm up.

Laser delay is set incorrectly Adjust the laser delay settings. See Manual settings (page 87).

Laser is not functioning Verify the malfunction by changing the threshold to an alternative laser while running
the appropriate sample. If unsuccessful, contact BD Biosciences.

Tube is cracked or misshapen Replace the sample tube.
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No events in acquisition display and RUN button is orange

Possible causes Recommended solutions

RUN is not activated Press the RUN button.

Sample tube is not installed or is not
properly seated

Install the sample tube correctly on the SIP.

Sample tube is cracked Replace the sample tube.

Waste tubing line is disconnected from
the waste container tank

Connect the waste tubing line to the waste container tank.

Sheath container is not pressurized l Ensure that the sheath container lid and all connectors are securely seated.

l Inspect the sheath container O-ring inside the lid and replace it if necessary.
See Cleaning or replacing the sheath gasket (page 45)

Bal seal is worn Replace the Bal seal. See Changing the Bal seal (page 42).

Air leak at sheath container Ensure that the sheath container lid and all connectors are securely seated.

Sheath container is empty Fill the sheath container.

Air in sheath filter Purge the filter. See Removing air bubbles (page 27).

No fluorescence signal

Possible causes Recommended solutions

Incorrect fluorochrome
assignment

Make sure that the cytometer configuration in the software matches the optical filters in the
cytometer and the configuration is as expected.

Laser is not functioning Call your BD service representative.

No signal in red laser channels (when red laser is installed)

Possible causes Recommended solutions

Incorrect laser delays due to a change in the sheath tank fluid
level

l Check the fluid level in the sheath tank and refill if
necessary.

l Adjust the laser delay settings. See Manual settings
(page 87).
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High event rate

Possible causes Recommended solutions

Air bubbles in the sheath filter or
flow cell

Remove the air bubbles. See Removing air bubbles (page 27).

Threshold level is too low Increase the threshold level. See the BD FACSDiva™ Software Reference Manual
for instructions.

PMT voltage for the threshold
parameter is set too high

Set the PMT voltage lower for the threshold parameter. See the BD FACSDiva™
Software Reference Manual for instructions.

Sample is too concentrated Dilute the sample.

Sample flow rate is set to HIGH Set the sample flow rate to MED or LOW.

Low event rate

Possible causes Recommended solutions

Threshold level is too high Lower the threshold level. See the BD FACSDiva™ Software Reference Manual for
instructions.

Air bubble or debris in the flow cell Prime the fluidics system. See Preparing the fluidics (page 31).

PMT voltage for the threshold
parameter is set too low

Set the PMT voltage higher for the threshold parameter. See the BD FACSDiva™
Software Reference Manual for instructions.

Sample is not adequately mixed Mix the sample to suspend the cells.

Sample is too diluted Concentrate the sample. If the flow rate setting is not critical to the application, set
the flow rate switch to MED or HIGH.

Sample injection tube is clogged Remove the sample tube to allow backflushing.

If the event rate is still erratic, clean the sample injection tube. See Cleaning the
fluidics (page 37).

Erratic event rate

Possible causes Recommended solutions

Sample tube is cracked Replace the sample tube.

Air bubble or debris in the flow
cell

Prime the fluidics system. See Preparing the fluidics (page 31).

Bal seal is worn Replace the Bal seal. See Changing the Bal seal (page 42).

Sample injection tube is
clogged

Remove the sample tube to allow backflushing.

If the event rate is still erratic, clean the sample injection tube. See Cleaning the fluidics
(page 37).

Contaminated sample Prepare the specimen again. Ensure that the tube is clean.

Sheath filter is dirty Replace the filter. See Changing the sheath filter (page 41).
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Distorted scatter parameters

Possible causes Recommended solutions

Cytometer settings are improperly
adjusted

Optimize the scatter parameters. See the BD FACSDiva™ Software Reference
Manual for instructions.

Air bubble in the sheath filter or
flow cell

Purge the air from the filter. See Removing air bubbles (page 27).

Flow cell is dirty Flush the system. See Flushing the system (page 38).

Air leak at sheath container Ensure that the sheath container lid is tight and all connectors are secure.

Hypertonic buffers or fixative Replace the buffers or fixative.

Excessive amount of debris in display

Possible causes Recommended solutions

Threshold level is too low Increase the threshold level.

Sheath filter is dirty Replace the filter. See Changing the sheath filter (page 41).

Flow cell is dirty Flush the system. See Flushing the system (page 38).

Dead cells or debris in the
sample

Examine the sample under a microscope.

Sample is contaminated Re-stain the sample. Ensure that the tube is clean.

Stock sheath fluid is
contaminated

Rinse the sheath container with DI water, then fill the container with sheath fluid from
another (or new lot) bulk container.
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High CV or poor QC results

Possible causes Recommended solutions

Air bubble in sheath filter or flow cell l Purge the filter. See Removing air bubbles (page 27).

l Prime the fluidics system. See Preparing the fluidics (page 31).

Sample flow rate is set too high Set the sample flow rate lower.

Air leak at sheath container Ensure that the sheath container lid is tight and all connectors are
secure.

Flow cell is dirty Flush the system. See Flushing the system (page 38).

Waste tank is pressurized Replace the waste container cap. See Replacing the waste container
cap (page 40).

Poor sample preparation Repeat sample preparation.

Sample was not diluted in the same fluid as the
sheath fluid

Dilute the sample in the same fluid as you are using for sheath.

Old or contaminated QC particles Make new QC samples and perform the quality control procedure
again.

Instrument is not warmed up Wait 30 minutes for the instrument to warm up.

Laser is not functioning Contact BD Biosciences.

Optical alignment problem Contact BD Biosciences.

Carryover from previous sample observed

Possible causes Recommended solution

Residual sample in sample injection tube or
fluidic system from previous tests

Clean the sample injection tube and, if carryover is still observed, clean
the fluidics (see Cleaning the fluidics (page 37).

Electronics troubleshooting

Introduction

This topic describes possible problems and recommended solutions for electronics issues.

“Cytometer Disconnected” in cytometer window

Possible causes Recommended solutions

Cytometer power is off Turn on the cytometer main power.

Communication failure between
workstation and cytometer

1. In BD FACSDiva™ software, select Cytometer > Connect.

2. If connecting does not work, restart the cytometer. Turn the cytometer off, wait
1 minute, and turn on the cytometer main power.

3. If connecting still does not work, contact BD Biosciences.
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Supplies and consumables
This chapter covers the following topics:
l Ordering information (page 104)
l Beads (page 104)
l Reagents (page 105)
l Equipment (page 105)



Ordering information
To order spare parts and consumables from BD Biosciences:
l Within the US, call (877) 232-8995.
l Outside the US, contact your local BD Biosciences customer support representative.

Worldwide contact information can be found at bdbiosciences.com.

Beads

Introduction

This topic lists the QC and CS&T beads available.

QC particles

Particle Laser Supplier Catalog No.

SPHERO™ Rainbow Calibration
Particles (8 peaks)

All BD Biosciences 559123

SPHERO™ Ultra Rainbow Fluorescent
Particles (single peak)

All Spherotech, Inc. URFP-30-2

BD® DNA QC Particles Blue (488 nm) BD Biosciences 349523

CS&T beads

Bead Laser Supplier Catalog No.

BD® Cytometer Setup and
Tracking Beads for
BD FACSDiva™

l UV (355 nm)

l Violet (405 nm)

l Blue (488 nm)

l Red (637 nm)

l Yellow-green
(561 nm)

BD Biosciences l 641319 (50 tests)

l 642412 (150 tests)

104 BD FACSymphony™ A5 SE User's Guide

http://www.bdbiosciences.com/


Reagents
Reagent Supplier Catalog No.

BD FACSFlow™sheath fluid BD Biosciences 342003

BD FACS™ Sheath Solution with
surfactant (recommended for use
with the HTS option)

BD Biosciences 336524

Monoclonal antibodies BD Biosciences See the BD Biosciences Product
Catalog or the BD Biosciences
website (bdbiosciences.com)

BD FACS™ Lysing solution BD Biosciences 349202

BD® Detergent Solution
Concentrate

BD Biosciences 660585

BD FACSClean™ BD Biosciences 340345

Dyes and fluorochromes BD Biosciences, Life Technologies, or Sigma –

Chlorine bleach
(5% sodium hypochlorite)

Clorox® or other major supplier (to ensure that
the bleach is at the correct concentration and
free of particulate matter)

–

Equipment
Equipment item Supplier Catalog No.

Bal seal BD Biosciences 343509

O-ring, sample tube 343615

Sheath filter assembly 34364507

Waste tank caps , pack of 12 338854

Baffle SPA 10L waste tank ext 338505

Falcon® polystyrene test tubes, 12 x 75-mm Corning 352008
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A

acridine orange (AO) 37
air bubbles, removing 27
alarm

waste container 19
analysis

data 78
immunophenotyping 81
reusing 84
saving 85

AO See acridine orange 37
application settings

applying 79
creating 72

area scaling 90
arm, tube support 18
aspiration (sample), rapid 96
assistance, technical 10
autofluorescence 52

B

Bal seal
ordering 105
replacing 42

BD detergent solution 37
BD FACSClean solution 105
BD FACSDiva software See software 8
BD FACSFlow sheath fluid 105
BD FACSFlow solution 27
BD FACSFlow supply system 24, 38
BD High Throughput Sampler (HTS) 18
bleach 36, 105
bubbles, removing air 28
buttons

fluid control 15
sample flow rate control 16

C

calculating compensation 76
capacity, waste container 19
cleaning solutions 36
compensation

calculating 76
control tubes 73
recording settings 74

compensation controls 56
components

sheath container shown 26
sheath filter shown 41
waste container shown 30

computer system, about 22
configuration

BD FACSDiva 65
containers

sheath 19, 25
waste 19, 29, 31

control
single-stained 65, 78

control panel, cytometer 14
controls

fluidics 14
conventions

safety symbols 8
creating

analysis objects 81
global worksheets 78
statistics view 81

CS&T particles 104
cuvette flow cell 88
CV, troubleshooting 101
cytometer 12

configuration 65
disconnect error 102
setup 64



starting 24
troubleshooting 96

D

DAPI, cleaning after using 37
data

analyzing 78, 81
gating 81
recording 78-79

debris, excessive 100
delay, laser 88
detector arrays 20
detector parameters 49
detectors 21
detergent solution 37
digital data 12
Diva software See software 8
droplet containment system 19

E

electronics
troubleshooting 101

event rate
erratic 99
high 99
low 99
zero 97-98

excessive debris 100
experiments

creating 69
immunophenotyping 78
sample optimization 69
specifying parameters 70

F

FACSFlow sheath fluid [f] 105
FACSFlow solution[f] 27
Falcon tubes 96
filters, sheath

attaching new 42
replacing 41

fixed-alignment lasers 12
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draining 31

flow rate control buttons 16
fluid control buttons

PRIME 15
RUN 15
STANDBY 15

fluidics
description 15
flow rate control 16
flushing system 38
priming 31
removing air bubbles 28
run mode 15
sample injection port (SIP) 17-18

fluidics controls, cytometer 14
fluidics interconnect 29
fluorescence signal, none 98
flushing the system 38

G

gating data 81
global worksheets

analyzing data 81
creating 78
previewing data 78, 84

H

hazard symbol definitions 8
High Throughput Sampler (HTS) 18

I

immunophenotyping
analysis 81
experiment 78

L

laser channels 48
laser delay

about 88
optimizing 89
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lasers
options 20
performance check 67
quality control (QC) particles 104

M

maintenance
Bal seal 42
cytometer shutdown 38
sample tube O-ring 44
schedule 36
scheduled 38
sheath filter 41
system flush 38

O

O-ring
ordering 105
replacing 44
worn 96

optics
components 20
configuration 65-66
filters 20

optimization, sample 64
ordering

waste tank baffle 105
ordering spare parts 104

P

parameter labeling 54
particles 104
performance check 67
photodiode 21
photomultiplier tubes (PMTs) 21
PMT See photomultiplier tubes 21
population hierarchy 81
primary detector allocations 52
PRIME, fluid control button 15
priming fluidics system 31
propidium iodide (PI) 37

Q

quality control (QC)
particles 104
troubleshooting 101

R

recording
compensation settings 74
compensation tubes 73
data 78-79

removing air bubbles, filter 28
replacing

Bal seal 42
sample tube O-ring 44
sheath filter 41
waste air filter 40, 45

reusing analyses 84
RUN

button orange 98
fluid control button 15

S

safety symbol definitions 8
safety symbols 8
sample

optimization 64
optimization experiment 69
optimization, single-stained control 65, 78

sample injection port (SIP)
components 17-18
replacing Bal seal 42
replacing sample tube O-ring 44

sample tube
injection 18
not fitting 96
requirements 96

samples, running 79
saving analyses 85
scatter

parameter distortion 100
setup, cytometer 64



sheath container
components shown 26
defined 19
depressurize 26
preparing 26

sheath filter
components shown 41
ordering 105
removing air bubbles 27
replacing 41

sheath fluid
backflush 19
BD FACSFlow sheath fluid 105

signals, amplifying 21
single-color controls 57
single-stained control 48, 52-53, 75-76
single-stained setup 58
software

cytometer control 8
version 22

spare parts, ordering 104
Spectral 47
spectral experiment setup 53
spectral functions

overview 48
spectral unmixing 52, 56
STANDBY, fluid control button 15
starting cytometer 24
statistics views 81
support, technical 10

T

technical assistance 10
thiazole orange (TO) 37
TO See thiazole orange 37
troubleshooting

cytometer 96
electronics 101

tubes
Falcon 96
requirements 96
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user preferences 66

W

waste air filter
component shown 30

waste container 19
alarm 19
capacity 19
components shown 30
defined 19
emptying 29

waste tank baffle
ordering 105

waste tank caps
ordering 105

window extension 89
workstation, about 22
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